Line Design

Release 4.6C

SAP
Copyright

© Copyright 2001 SAP AG. All rights reserved.

No part of this publication may be reproduced or transmitted in any form or for any purpose without the express permission of SAP AG. The information contained herein may be changed without prior notice.

Some software products marketed by SAP AG and its distributors contain proprietary software components of other software vendors.

Microsoft®, WINDOWS®, NT®, EXCEL®, Word®, PowerPoint® and SQL Server® are registered trademarks of Microsoft Corporation.

IBM®, DB2®, OS/2®, DB2/6000®, Parallel Sysplex®, MVS/ESA®, RS/6000®, AIX®, S/390®, AS/400®, OS/390®, and OS/400® are registered trademarks of IBM Corporation.

ORACLE® is a registered trademark of ORACLE Corporation.

INFORMIX®-OnLine for SAP and Informix® Dynamic Server™ are registered trademarks of Informix Software Incorporated.

UNIX®, X/Open®, OSF/1®, and Motif® are registered trademarks of the Open Group.

HTML, DHTML, XML, XHTML are trademarks or registered trademarks of W3C®, World Wide Web Consortium, Massachusetts Institute of Technology.

JAVA® is a registered trademark of Sun Microsystems, Inc.

JAVASCRIPT® is a registered trademark of Sun Microsystems, Inc., used under license for technology invented and implemented by Netscape.

SAP, SAP Logo, R/2, RIVA, R/3, ABAP, SAP ArchiveLink, SAP Business Workflow, WebFlow, SAP EarlyWatch, BAPI, SAPPHIRE, Management Cockpit, mySAP.com Logo and mySAP.com are trademarks or registered trademarks of SAP AG in Germany and in several other countries all over the world. All other products mentioned are trademarks or registered trademarks of their respective companies.
## Icons

<table>
<thead>
<tr>
<th>Icon</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Caution Icon" /></td>
<td>Caution</td>
</tr>
<tr>
<td><img src="image" alt="Example Icon" /></td>
<td>Example</td>
</tr>
<tr>
<td><img src="image" alt="Note Icon" /></td>
<td>Note</td>
</tr>
<tr>
<td><img src="image" alt="Recommendation Icon" /></td>
<td>Recommendation</td>
</tr>
<tr>
<td><img src="image" alt="Syntax Icon" /></td>
<td>Syntax</td>
</tr>
<tr>
<td><img src="image" alt="Tip Icon" /></td>
<td>Tip</td>
</tr>
</tbody>
</table>
## Contents

**Line Design** ............................................................................................................................... 6
**Carrying Out Line Design** ............................................................................................................ 8
**Rates and Takt Times** .................................................................................................................. 11
**Rate Routing** ............................................................................................................................... 13
**Processing the Rate Routing** ..................................................................................................... 14
  - Phantom Work Center .............................................................................................................. 16
  - Create a Rate Routing ............................................................................................................... 17
  - Create a Sequence for the Main Production Line ...................................................................... 18
  - Create a Sequence for a Feeder Production Line ....................................................................... 19
    - Example for a Feeder Production Line ....................................................................................... 21
  - Display Rate Routing in Graphic ............................................................................................... 23
  - Copy Rate Routing as a Template ............................................................................................... 24
**Line Hierarchy** .............................................................................................................................. 25
  - Example for Line Hierarchy ....................................................................................................... 26
**Processing the Line Hierarchy** .................................................................................................... 28
  - Production Line ......................................................................................................................... 30
  - Takts .......................................................................................................................................... 31
  - Creating Work Centers ............................................................................................................... 32
  - Create Line Hierarchy ................................................................................................................ 34
  - Processing the Line Hierarchy Using the Graphic .................................................................... 35
    - Create Line Segments ............................................................................................................... 37
    - Defining Number of Takts and Capacities ............................................................................... 39
      - Example: Number of Takts and Capacities ......................................................................... 41
    - Defining Sort Buffers .............................................................................................................. 43
    - Defining Processing Profiles ................................................................................................... 45
    - Defining Planning Segments .................................................................................................... 46
    - Defining Planning Visualization Segments ............................................................................. 48
      - Define Planning Visualization Segments ............................................................................. 49
    - Defining Controlling Visualization Segments ........................................................................ 50
    - Defining Capacity Segments ................................................................................................... 51
    - Defining Standard Buffers ........................................................................................................ 52
  - Manually Create Planned Rate ................................................................................................... 53
  - Material-Dependent Rate ........................................................................................................... 54
    - Enter Material-Dependent Rates .............................................................................................. 56
**Line Balancing** .............................................................................................................................. 57
**Processing Line Balances** .......................................................................................................... 59
  - Takts .......................................................................................................................................... 61
    - Example: Number of Takts and Capacities ............................................................................. 62
  - Work Content ............................................................................................................................. 64
  - Routing Selection ....................................................................................................................... 65
  - Process Line Balances ............................................................................................................... 67
  - Enter the Model Mix ................................................................................................................... 69
    - Enter Material Variants in the Model Mix ............................................................................ 71
  - Balancing Lines Using the Graphic ............................................................................................ 72
Renumbering Operations ................................................................................................................... 74
Moving Operations ............................................................................................................................ 75
Adjusting the Available Capacity ........................................................................................................ 76
Carrying Out Line Balancing in the Graphic ...................................................................................... 77
Displaying Execution Times .................................................................................................................. 79

**Changing the Operative Rate/Takt Time** ..................................................................................... 81
Change the Rate/Takt Time .................................................................................................................. 82

**Operational Method Sheets** ........................................................................................................... 83
Printing Operational Method Sheet (OMS) .......................................................................................... 85
Grouping Materials............................................................................................................................... 87
Set Word Processing System .............................................................................................................. 89
Print Operational Method Sheets ....................................................................................................... 90
Line Design

Purpose

With this component you define the basic data for the repetitive manufacturing planning tools, the planning table and Sequencing. With Line Design you can control the takt-based scheduling of Sequencing. In Line Design you can also create basic data, if you work with lead time scheduling and if you use the planning table with the graphic planning board.

The following examples include further information on the uses of Line Design.

Example 1: Rate-Based Make-to-Stock Repetitive Manufacturing [Ext.]
Example 2: Takt-Based Make-to-Stock Repetitive Manufacturing [Ext.] (model mix)
Example 3: Make-to-Stock Repetitive Manufacturing [Ext.] (with lead time scheduling and capacity planning)
Example: Make-to-Order Repetitive Manufacturing [Ext.] (model mix).

Implementation Considerations

You can implement Line Design as follows, depending on the type of production you use:

- Takt-based production of a model mix.
  This process can be used if you manufacture several similar materials or several variants of a material on one production line at one time (model mix production). You can use the process with make-to-order repetitive manufacturing and make-to-stock repetitive manufacturing if you work with takt-based scheduling. To do so you create a rate routing and a line hierarchy and periodically carry out a line balance. You can adjust the capacity of the production line per period for a specific model-mix.

- Production based on production rates
  This process is, above all, relevant for make-to-stock repetitive manufacturing. It is used if you always produce only one material on a production line at the same time. Here, you can work with lead time scheduling or with takt-based scheduling. If you work with takt-based scheduling, you only require one line hierarchy. A rate routing is optional. For mid to short term production planning, manually enter a planned rate per period. In addition, you can also enter material-dependent rates if the rates of the materials vary.

Integration

- Line Design is assigned to the master data of the component Production Planning and Control (PP).

- The production rates and takt times and the number of takts on the production line are used in Sequencing to schedule planned orders. You can also implement Sequencing in conjunction with the planning table. You can use the planning table to create planned orders and assign them to production lines. The planned orders are then dispatched and scheduled in Sequencing. You can access Sequencing from the planning table to display planning results in a graphic.
Features

- You can reproduce production processes by creating a rate routing. A rate routing is a routing, which deals with the special functions in repetitive manufacturing. You can define a main production line and several parallel feeder production lines.

- You can reproduce the processing stations of a production line structured in the system, by creating a line hierarchy. In the line hierarchy you can insert as many work centers and line segments in as many hierarchy levels as you wish. You can divide the line segments into taks, which represent the actual processing stations of the production line.

- You can carefully control takt-based scheduling in Sequencing by using several Rates and Takt Times [Page 11]

- In the line hierarchy you can insert sort buffers between line segments, in order to divide the production line. So, in Sequencing you can change the sequence of the planned orders in a sort buffer. In addition, you can specify various operating times for the buffered sections.

- You can create a line hierarchy with line balancing. In line balancing, you can define the following master data for planning purposes:
  - you plan the materials to be produced and the corresponding production quantities for the period (model mix)
  - in the line balancing graphic, you can analyze the capacity load utilization on the takts and move operations to other takts, if necessary
  - you can close takts or work centers or change the individual capacity of a takt.

- If you have created a line hierarchy without line balancing, you can also enter material-dependent rates.

Constraints

- The rates of a production line are valid for all line hierarchies. You cannot assign differing rates to line segments.

- If you use rate routings that refer to reference rate routings or standard routings, you cannot move the corresponding operations in the line balancing graphic.
Carrying Out Line Design

Purpose

This process describes how to make efficient use of Line Design to create master data for planning your flow or repetitive manufacturing.

Process Flow

The following describes the various processes for takt-based production and rate-based production.

Line Design with Line Balancing for Takt-Based Production

1. Processing the Rate Routing [Page 14]

   Start by creating a rate routing to represent your production process. Here, you define all the operations required for production of the various materials, and enter the standard values. Line segments (work centers) have generally not yet been defined when you create the rate routing. Therefore, you can initially enter a phantom work center and assign line segments and takts later (see step 3). If the line segments and takts have already been defined, enter them. You can also use parallel sequences to define feeder production lines.

2. Processing the Line Hierarchy [Page 28]

   a) You create the work centers: the work center that represents the production line (line hierarchy header) and one work center for each line segment.

   b) You assign the materials to the production line by creating a production version in the appropriate material master and entering the work center, that you would like to use as the line hierarchy header.

   c) You create a line hierarchy, for which you plan to carry out line balancing.

   d) You define the time unit and the unit of measure for the production line.

   e) If you have already defined the maximum production rate (or minimum takt time) for the production line, enter it. You also have the option of defining the maximum production rate later, in line balancing.

   f) You define the structure of your production line by editing the line hierarchy in the graphic display.

3. Assignment of Operations to Line Segments

   You assign the operations of the rate routing to the line segments and takts by replacing the phantom work centers in the rate routing by the line segments. If you want to keep the rate routing with the phantom work centers as a template for other production versions, you can first of all Copy Rate Routing as a Template [Page 24].

4. Processing Line Balances [Page 59]

   With the line balance you periodically determine a model mix and adjust the capacity of the production line to this model mix. For each period, you can create a version of a line balance. In the line balance, you enter the production quantities for the various materials (model mix), which results in a planned rate. You can then check the distribution of...
Carrying Out Line Design

operations over the processing stations (takts). If necessary, you can move operations and change the number of takts and number of individual capacities on a line segment.

5. **Entering an Operative Production Rate or Takt Time [Page 81]**
   
   If changes occur in your demand program at very short notice, you can overwrite the planned production rate for a specific amount of time by entering an operative production rate or takt time. For example, if one member of personnel takes sick leave at short notice, you can change the takt time for a shift.

### Line Design for Rate-Based Production with Takt-Based Scheduling

1. **Processing the Rate Routing [Page 14]**
   
   If you do not create a line balance for your line hierarchy, you do not necessarily require a rate routing. However, you can represent the production process using a rate routing, if you want, for example to create a standard cost estimate.

2. **Processing the Line Hierarchy [Page 28]**
   
   a. You create the work centers for the line hierarchy: the work center that you would like to use as the production line (line hierarchy header) and one work center for each line segment.
   
   b. You assign the materials to the production line by creating a production version in the appropriate material master and entering the line hierarchy in the production version.
   
   c. You create a line hierarchy, for which you do not plan to carry out line balancing.
   
   d. You define the time unit and the unit of measure for the production line.
   
   e. You define the maximum production rate for scheduling in **Sequencing**.
   
   f. You define the structure of your production line by editing the **Line Hierarchy [Page 25]** in the graphic display.
   
   g. For those periods, in which you do not want to produce at the maximum rate, manually enter a planned production rate.
   
   h. If the planned rates vary for individual materials, enter the material-dependent rates.

3. **Entering an Operative Production Rate or Takt Time [Page 81]**
   
   If changes occur in your demand program at very short notice, you can overwrite the planned production rate for a specific amount of time by entering an operative production rate or takt time. For example, if one member of personnel takes sick leave at short notice, you can change the takt time for a shift.

### Line Design for Rate-Based Production with Lead Time Scheduling

1. **Processing the Rate Routing [Page 14]**
   
   If you work with lead time scheduling, determine the rates in the rate routing by setting the standard values on a base quantity. Here then, the rate routing is the basis for the lead time scheduling. In accordance with these rates, the system schedules the production quantities and determines the capacity requirements.

   Enter the operations which are necessary for manufacturing the material. Line segments (work centers) have generally not yet been defined when you create the rate routing. Therefore, you can initially enter a phantom work center and assign line segments later (see step 3). If the line segments have already been defined, enter them.
Carrying Out Line Design

2. **Processing the Line Hierarchy [Page 28]**
   a. You create the work centers for the line hierarchy: the work center that you would like to use as the production line (line hierarchy header) and one work center for each line segment.
   b. You assign the materials to the production line by creating a production version in the appropriate material master and entering the line hierarchy in the production version.
   c. You create a line hierarchy, for which you do not plan to carry out line balancing.
   d. You define the time unit and the unit of measure for the production line.
   e. You define the structure of your production line by editing the Line Hierarchy [Page 25] in the graphic display.
   f. You define line segments as capacity segments, whose capacity requirements you want to display in the planning table.

3. Assignment of operations to line segments.
   You assign the operations of the rate routing to the line segments and takts by replacing the phantom work centers in the rate routing by the line segments. If you want to keep the rate routing with the phantom work centers as a template for other production versions, you can first of all Copy Rate Routing as a Template [Page 24].
Rates and Takt Times

Definition

The rates or takt times define the parameters for the takt-based scheduling of planned orders. You can enter this master data in Line design.

Line design differentiates between the three following rates and takt times, with which you can plan your production. Therefore, the takt time is the reciprocal of the rate entered.

- Maximum rate/minimum takt time

  With this takt time you can define the maximum capacity of the production line on a long-term basis. The minimum takt time is the time in which a material is retained for processing in a takt [Page 61] (processing station) of the production line. Therefore, if you give a material in the production line a time interval of the minimum takt time, then in this time interval one material will be completed. The production line produces the maximum rate and the maximum production quantity.

- Planned rate/planned takt time

  This takt time gives the time interval in which a material joins the production line and a processed material leaves the production line. It therefore determines the time that passes between the completion of two units of measure of a product on the production line. With the planned rate you can plan the production rate for a period for the short to medium term. You can enter the planned rate manually or set it in a line balance.

- Operative rate/operative takt time

  The operative production rate overwrites the planned rate. With this rate you can react to any short term changes in requirements or supply. For example, if an employee takes sick leave at short notice, you can reduce the takt time for a shift. You can change the operative production rate/takt time from the sequence schedule or from the planning table.

<table>
<thead>
<tr>
<th>Production rates</th>
<th>Takt times</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Description</strong></td>
<td><strong>Example</strong></td>
</tr>
<tr>
<td>Maximum rate</td>
<td>6 units per hour</td>
</tr>
<tr>
<td>Planned rate</td>
<td>5 units per hour</td>
</tr>
<tr>
<td>Operative rate</td>
<td>4 units per hour</td>
</tr>
</tbody>
</table>

- Material-dependent production rates

  The material-dependent rate overwrites the planned rate for a specific material. You can enter Material-Dependent Rates [Page 54] in a line hierarchy without a line balance. You enter the material-dependent rate in relation to the time-independent maximum rate of the production line and the system stores this rate as a factor. With scheduling, this factor is multiplied by the time-independent planned rate. If you have created a line hierarchy with line balancing, you can enter the material-dependent rates using the model-mix in the line balance.
Rates and Takt Times

Use

Using the rates and takt times you can plan the production quantities of a production line for both the long term as well as the medium and short term. If you simply enter a maximum rate, the minimum, planned and operative rates are all identical. By manually entering the planned rates or by using line balancing, you can change the production quantities for a period. If your planning changes at short notice, you can enter an additional operative production rate.

With rate-based production you can enter all three rates in the line hierarchy. With takt-based production you determine the planned rate using the model mix in the line balance.

Integration

When you work with Sequencing, you must enter a maximum rate. You define the time for which a material can be processed in a takt of the production line.

Sequencing takes the rates and takt times into consideration in both takt-based and rate-based production.
Rate Routing

Definition

The rate routing represents the production process of flow and repetitive manufacturing. It describes which operations you carry out in producing a material as well as the time and sequence used. In addition, the rate routing includes information about the line segments (work centers) in which you carry out the individual operations and also the necessary production resources/tools.

In a rate routing you can also represent feeder lines. Feeder lines are lines parallel to the main line on which operation sequences are carried out. They are intended to reduce the lead time. You represent these parallel production processes by creating parallel sequences in the rate routing. (Example for Parallel Sequences [Page 21]).

Use

- If you create a rate routing, you can assign the corresponding line segments (work centers) or takts within the line segment to the operations. First of all you can also assign phantom work centers to the operations and after you have created the line hierarchy you can enter the line segments and takts in the rate routing.

- You can enter the line hierarchy in the header of the rate routing. You do not necessarily require a rate routing for repetitive manufacturing. For rate-based production it is sufficient to create a line hierarchy and enter the rates there. A rate routing is necessary, for example, if you want to carry out a calculation.

Structure

The following functions are available for representing production processes in the rate routing:

- You can create parallel sequences to the main line in order to represent the feeder lines.

- You can create parallel sequences to a parallel sequence to represent the relationship between the individual feeder lines.

- A graphic display of the sequences and operations that you have created helps you with your planning.

- The rate routing displays the takts of a line segment in a separate column. You can assign operations directly to a takt.

- You can select operations which are not value-added and carry out evaluations in the line balance.
Processing the Rate Routing

Purpose

In this process, you create a rate routing. Rate routings are routings which enable you to reproduce the complex production processes of flow and repetitive manufacturing.

If you work with the line hierarchy without a line balance, you do not necessarily require a rate routing. You can enter the production rates for the takt time/rate-based scheduling in the line hierarchy. The system then uses only these production rates for planning in Sequencing. You need a rate routing if you want to create a standard cost estimate for a material, for example.

Process Flow

1. Create Work Centers [Page 32]
   Start by creating a work center as a phantom work center. You need a phantom work center because the structure of the production line is usually not yet established when you start planning. You can then assign all operations initially to the phantom work center when you create the rate routing. Later, when you have created the line hierarchy, you can assign the operations to line segments.

2. Create a Rate Routing [Page 17]
   Create the rate routing in the system and enter the routing header data.

3. Create a Sequence for the Main Production Line [Page 18]
   Establish which operations must be carried out one after the other on the main production line, and create the operations.

4. Create a Sequence for a Feeder Production Line [Page 19]
   If you want to carry out operations on synchronized feeder production lines parallel to the main production line, you define parallel sequences for these feeder production lines. You can also create parallel feeder production lines for the feeder lines themselves.
   Then enter the operations that you want to carry out on the individual feeder production lines.

5. Displaying Rate Routings in Graphic [Page 23]
   In the rate routing graphic, you can display and check your production process.

Result

You have created a rate routing, which is not yet assigned to a production line. You assign the routing when you have reproduced the structure of the production line in the line hierarchy. Then enter those work centers into the rate routing which you have inserted in the line hierarchy as line segments.

If you want to keep the rate routing with the phantom work centers as a template for other production versions, you can first of all Copy Rate Routing as a Template [Page 24].
Phantom Work Center

Definition
A phantom work center is a work center, which you can enter in the rate routing if the actual work center in which you want to produce has not yet been defined. You therefore do not assign the rate routing to a production line.

Use
Enter the same data for the phantom work center as you would like to enter later for the actual work centers.

If you want to create a line balance for your line hierarchy, you should enter the same standard value key. Otherwise you cannot move the operations in the line balancing graphic.
Create a Rate Routing

Procedure
1. Starting from the main Line Design menu, choose Rate routing → Create.
   The system displays the initial screen for rate routings.
2. Enter the plant, the material and in the field Group, the group to which you want to assign the rate routing.
3. Choose Enter.
   The system displays the screen Header details.
4. Enter the following data:
   - the routing description
   - the plant
   - the usage of the rate routing, i.e. production
   - the status, i.e. released
   - the unit of measure of the materials to be produced
5. Save your rate routing.

Result
You have created the rate routing. Continue creating the main production line and if necessary, feeder lines.
Create a Sequence for the Main Production Line

Prerequisites
You have created the rate routing in the system.

Procedure
1. From the initial screen of the rate routing or from the Header details screen, choose Sequences.
   The system displays the screen Sequence overview.
2. The system displays sequence 0, which corresponds to the main line. Enter a name for this sequence.
3. Choose Operations.
   The system displays the Operations overview screen for sequence 0.
4. Enter the operations that are to be carried out on the main production line. Enter the following data for each operation:
   - the (phantom) work center
   - a control key
   - an operation description
   - the standard values, e.g. for the setup time and the processing time
5. Save your rate routing.

Result
You have created a rate routing with a main production line. Continue by defining feeder production lines if necessary or accessing the graphic display of the rate routing.
Create a Sequence for a Feeder Production Line

Prerequisites
You have created the task list header and the main production line (sequence 0) for the rate routing.

Procedure

6. From the initial screen of the rate routing or from the Header detail screen, choose Sequences.
   The system displays the screen Sequence overview.
7. In the lines below sequence 0 create a parallel sequence. Enter the following data:
   - the sequence number, e.g. 1
   - the sequence description
   - the reference sequence
     If the feeder production line leads to the main production line, enter 0 here.
     If the feeder production line leads to another feeder line, enter the number of this line.
   - if necessary, the branch operation
     The branch operation specifies the operation in the main production line, before which the parts that are to be produced on the feeder line are supplied to the feeder line.
   - the return operation
     The return operation specifies the operation in the main production line, after which the parts that have been produced on the feeder line are to be supplied to the main line.
    The system displays the operation overview of the feeder line.
9. Create the operations that are to be carried out on the feeder line. Enter the following data for each operation:
   - the (phantom) work center
   - a control key
   - an operation description
   - the standard values, e.g. for the setup time and the processing time
10. Save your rate routing.

Result
You must have created a feeder line. To test the production process, you can now access the graphic display of the rate routing.
Create a Sequence for a Feeder Production Line
Example for a Feeder Production Line

This example describes how the finished product is processed on three parallel production lines. The finished product is assembled on the main line. After operation 30, an assembly is delivered to the main line that was produced in parallel on feeder line 1.

A part of the assembly is produced in parallel to feeder line 1 on feeder line 2. This part is delivered to feeder line 1 after operation 1.

To represent this production process in the rate routing, proceed as follows:

1. Create sequence 0 for the main line and then create operations 1 to 4 for sequence 0.
2. Create sequence 1 for feeder line 1 and specify sequence 0 as the reference sequence and operation 30 as the return operation. Operation 30 on the main line directly precedes the delivery of the assembly. Next create the operations for sequence 1.
3. Create sequence 2 for feeder line 2 and specify sequence 1 as the reference sequence and operation 1 of sequence 1 as the return operation. The return operation here is operation 10 in sequence 1. Next create the operations for sequence 2.

If a parallel line exists for a main line that is linked to the main line at the beginning and the end of the main line, you must also specify the branch operation as well as the return operation. The branch operation is the operation before which the operation sequence begins on the parallel production line.
Example for a Feeder Production Line
Display Rate Routing in Graphic

1. In the sequence overview of the rate routing, choose 
   This takes you to the graphic display of the sequence overview.

2. If you want to display the operations of a sequence, select the sequence desired and choose
   The graphic displays the following information for each operation:
   a. the operation number
   b. the work center
   c. the duration of the operation
   d. the execution time is calculated using the formula defined in the work center
   e. the splitting
   f. the takt
   g. the operation description

3. If you want to display the operations of all sequences, choose 

4. To display the legend for the information in the operations graphic, choose Settings
   Legend → Left or Right or Below (the selection determines where the system displays the
   legend in the graphic).
Copy Rate Routing as a Template

Use

- You have created a rate routing with phantom work centers and you want to keep this rate routing as a template for other production lines.
- You want to carry out a line balance, and in doing so change one or more rate routings. You want to keep the current status of this rate routing in the system.

Procedure

1. Starting from the main Line Design menu, choose Rate routing → Create.
   The system displays the initial screen for rate routings.
2. Enter the plant, the material and group number of the rate routing in the field Group.
3. Choose Copy from.
   The system displays the dialog box Select Type. The Rate routing is already selected.
4. Choose.
   The system displays the dialog box entitled Create Using Copy Function.
5. Enter the plant and the group of the rate routing you want to copy and choose.
   The system displays the screen entitled Create Rate Routing: Header Data Check.
6. Enter the name of the line hierarchy and check the copied header data.
7. If you want to continue with the line hierarchy allocation, choose.
   The system displays the operations overview for the main production line (sequence 0).
8. Save your rate routing.

Result

You have made a copy of the rate routing.

- Now replace the phantom work centers in the rate routing by the work centers, which you have inserted in the line hierarchy as line segments.
- If you want to carry out a line balance on the basis of a copied rate routing, you must first of all enter this in the production version.
Line Hierarchy

Definition

The line hierarchy represents the structure of a production line in the system, by means of a graphic. It provides the master data for the takt based scheduling of Sequencing and allows you to control the display functions in Sequencing and in the planning table.

Use

- With the line hierarchy you reproduce the structure of a production line in the system. In this way, you can divide the production line into line segments over any number of hierarchy levels. You create a line segment by inserting a work center from the system into the line hierarchy.
- For each line segment you can enter the amount of takts (processing stations) and individual capacities (such as personnel or machinery).
- Enter the master data for the takt-based scheduling in the line hierarchy. As well as rates and takt times, you can also insert sort buffers into the line hierarchy. Sort buffers allow you to change the order sequence within the production line. You can enter the processing profile for Sequencing directly in the line hierarchy.
- In the line hierarchy you can define the visualization segments, the planning segments and the capacity segments for Sequencing and for the planning table.

Structure

- The production line forms the header of the line hierarchy; the line segments are the only elements of the line hierarchy that you arrange hierarchically.
- The line hierarchy contains an overview, in table form, of the planned production rates.
- The line hierarchy contains an overview of the assigned materials.
- The line hierarchy includes an object tree which represents the line segments and their properties.
- If you create a line hierarchy without line balancing, the line hierarchy contains an overview of the material-dependent rates.
- You can display and process the line hierarchy in a graphic. The graphic display of a line segment displays the number of takts and the number of individual capacities. The figures are condensed into the hierarchy levels above the line segments. The graphic display also shows whether the takts of the line segment are relevant for the line balance or not.

Integration

Enter a work center in the system for the header of the line hierarchy and for all further line segments.
Example for Line Hierarchy

Line hierarchy

This example describes a production line with a simple line hierarchy. As a material flows through three cost centers in production, the production line was split into three line segments. In the system, one work center is created for each line segment. Two takts are assigned to each line segment. This means that a material produced on this production line must flow through a total of 6 takts. The production line does not contain any sort buffers. Therefore, the sequence of the planned orders cannot be changed in the production line.

Takt times and production rates

A maximum production rate of 6 pieces per hour is specified for the production line. Therefore, when the production line is at maximum speed (planned production rate = 6 pieces per hour), a material arrives at the production line at takt 1 every 10 minutes. Similarly, a material leaves the production line at takt 6 every 10 minutes.

In this example, the maximum production rate is used as the basis for takt-based scheduling. This means that the speed of the production line is constant and a material can be processed for 10 minutes in each takt.

To adjust production to the number of orders in the current period, a planned production rate of only 3 pieces per hour is specified for this period. Therefore, one takt is always missed out and only every 20 minutes is a material placed on the production line at takt 1 or leaves the production line at takt 6. The lead time of the order increases if production is interrupted due to either a break or a shift change.

See also:
Takt-based scheduling [Ext.]

**Visualization in the Sequence Schedule (Planning View)**

As there are no sort buffers in the line hierarchy, only one row is displayed in the sequence schedule for the complete production line. The view of the sequence schedule is set to the line-on view. Therefore, the sequence schedule displays when the planned orders in segment 1 arrive at the production line (production start date).
Processing the Line Hierarchy

Purpose
You use this process to reproduce the structure of your production line in the system.

- You can divide the production line into line segments and assign these line segments a number of takts and a number of individual capacities.
- You can enter production rates or takt times and thus control takt-based scheduling.

The line hierarchy provides master data for the repetitive manufacturing planning tools, the *Planning table* and *Sequencing*.

Prerequisites
You must have created a production version in the material master for each material that you want to produce on the production line. Enter the production line and the rate routing in the production version. The production line is the work center, which you want to use as the header of the line hierarchy. When you access the line hierarchy, the system refers to the production version to determine the materials assigned.

Process Flow

1. **Create Work Centers [Page 32]**
   
   You must create a work center for every line segment (structure node) that you want to represent in the line hierarchy. However, you can assign several takts to one line segment in the line hierarchy. The system distributes the work center capacity evenly over the takts.

2. **Create Line Hierarchy [Page 34]**
   
   You create a line hierarchy, specifying whether or not you want to carry out line balancing. You then enter the time unit and the unit of measure for the production line. If you know the maximum production rate for the production line, enter it now. However, you can also enter the maximum production rate later, such as when you have carried out line balancing.

3. **Processing the Line Hierarchy Using the Graphic [Page 35]**
   
   You reproduce the structure of your production line in the line hierarchy graphic. The structure defines the master data for the *Planning table* and *Sequencing*. You can select various views and then define planning segments, visualization segments and capacity segments. You can also define processing profiles for sequence planning in *Sequencing*.

4. **Defining Planned Production Rates [Page 53]**
   
   If you created a line hierarchy without line balancing, enter the planned rates for those periods whose production rate differs from the maximum rate.

5. **Defining Material-Dependent Production Rates [Page 54]**
   
   If you have created a line hierarchy without line balancing and you want to produce your materials with different rates, you can also enter material-dependent rates.
Result
You have reproduced the complete structure of your production line in the system.

- You can display the line hierarchy as an object tree. The object tree represents the defined line structure including the number of takts and individual capacities as the structure tree.

- If you have created a rate routing, you can enter the line hierarchy in the rate routing header.

- If you have entered dummy work centers in the rate routing, you can now enter the line segments in the rate routing.

- If you have planned a line balance for the line hierarchy, you can now carry this out.
Production Line

Definition
The production line reproduces the actual areas of flow or repetitive manufacturing in the system. It is, as a rule, a collection of several processing stations (takts) and is structured by the line hierarchy.

Use
- You can divide the production line into several larger line segments and group several processing stations in these. You create a work center for each line segment. You can then reproduce the structure in the system by means of the line hierarchy. You define the number of processing stations per line segment by the number of takts in the line segment.
- In the simplest case you can also create just one individual work center for a production line and use this as the header for the line hierarchy.

Structure
The production line and its line segments are created as a work center with work center categories. In the SAP standard system, several work center categories have been predefined. However, you can also create your own descriptions depending on your company's specific production structure (for example, line segment, station, zone).

See also:
Create Work Centers [Page 32]

For more information on maintaining production lines/work centers, please refer to the SAP Documentation PP - Work Centers [Ext.].
**Takts**

**Definition**

Takts are the processing stations in a production line. They are the spatial area that the material passes through in the predefined minimum takt time, where it is processed.

**Use**

You define the length of the production line by the number of takts. Alongside the rates and takt times, the number of takts that a material has to pass through is a further parameter for takt-based scheduling.

You can define the number of takts in the line hierarchy for a line segment. Since the number of takts on the production line must be uniform, you can only enter it in the branches of the line hierarchy (from the uppermost level downwards) on one level.

The number of takts on the lowermost level of the hierarchy gives you the number of takts on the uppermost level.

**See also:**

[Example: Number of Takts and Capacities [Page 62]]
Creating Work Centers

Use
You start by creating a work center for the line hierarchy header and for each line segment that you want to put in the line hierarchy. In the work center, you define the master data for the line segment, such as capacity and scheduling data. You then create the line segments by inserting the work centers in the line hierarchy.

Integration
You can create work centers in the Work Center menu.

See also:
SAP-Documentation PP-Work Centers [Ext.]

Features
The following work center data is particularly significant for Line Design and takt-based scheduling in Sequencing.

- Basic data
  - The standard value key controls the type of standard values in the rate routing (for example, setup time, personnel time). If you want to carry out line balancing for the line hierarchy, you enter the same standard value key for all the work centers. Otherwise, you cannot move the operations in the line balance.
  - The work center defines the color used to display the line segment in the line hierarchy. You can allocate this color to the work center type in Customizing for work centers.

- Capacity
  - You enter capacity categories and formulae for those work centers, for which you want to define the Number of takts and individual capacities [Page 39].
  - You enter a capacity category for the line segments, which Sequencing uses to determine the operating time (shift capacity) that is relevant for scheduling for the production line. Sequencing determines the operating time from the line hierarchy header as standard procedure. If you have split the production line up into buffered sections using sort buffers [Page 43], you can enter different operating times for each buffered section. You enter operating times for buffered sections in the first level of the hierarchy, for the first line segment of each buffered section.

- Scheduling
  - You enter capacity categories and formulae for the work centers, to which you want to assign operations, so that the system can calculate the duration of the operations.
  - Here, you enter the capacity category, which determines the operating time (shift capacity) relevant for scheduling for the production line.
Actions

Starting from the main menu of Line Design, select the menu path `Environment → Work centers` to branch to the Work Center menu.
Create Line Hierarchy

Prerequisites

- You have created a work center for the header and for all further line segments of the line hierarchy.
- If you would like to assign materials to the line hierarchy, enter the work center, which you would like as the header of the line hierarchy, into the production version of all materials. You create the production version with the planning data in the material master record.

Procedure

1. Starting from the main Line Design menu, choose Line hierarchy Create.
   The system displays the initial screen for rate routings.
2. Enter the plant and in the field Line hierarchy enter the work center which you would like to use as the line hierarchy header.
3. If you do not want to define the planned rates in Line balancing [Page 57], select the indicator No line balancing.
4. Choose ✓.
   The system displays the overview of the planned production rates.
5. Enter the unit of measure and the time unit for the line hierarchy.

   The units of measure, which you would like to produce on the production line must be convertible into the units of measure on the production line (e.g. grams and kilograms). If necessary create a conversion factor in the material master record.
6. If you already know the maximum rate of the production line, enter it. You can also determine the maximum rate using line balancing and then enter it in the line hierarchy. The reciprocal of the maximum rate is the minimum takt time. This defines how long a material is retained for processing in a takt of the production line.
7. Save the line hierarchy.

Result

You have created a line hierarchy. If necessary you can test the materials that are assigned to the production line by selecting the tab page Materials assigned.

Finally leave the graphic processing of the line hierarchy by choosing Line segments.
Processing the Line Hierarchy Using the Graphic

**Use**
You process the line hierarchy in the graphic in order to represent the structure of a production line [Page 30] in the system. You can create an unlimited number of subordinate line segments, over an unlimited number of hierarchy levels, below the line hierarchy header. You design the production line so that it can produce at maximum production rate (maximum load).

**Prerequisites**
- You must have created a line hierarchy.
- You must have created a work center for each line segment.

**Features**
- You can create line segments by inserting work centers in the line hierarchy and structuring them in the graphic.
- You can mark the line segments that represent the processing stations on the parallel feeder production lines.
- You can define the amount of takts in the line segments. This means that you do not have to create a separate work center for each processing station.
- You can enter the amount of individual capacities for all the capacity categories that you defined in the work center. The system does not copy the amount to the work center. It is only valid for the line hierarchy.
- You can define sort buffers, in order to split the production line into buffered sections. Per buffered section, you can enter one processing profile to change the sequence of planned orders. In the buffered sections, you can also define line segments as planning visualization segments or as a planning segment for Sequencing.
- You can define line segments as controlling visualization segments for the control view in Sequencing.
- You can define line segments as capacity segments if you use capacity planning in conjunction with the planning table. The capacity segment data is then displayed in the planning table.
- You can insert standard buffers in any level of the line hierarchy in order, for example, to represent a small interim storage location on your production line.

**Actions**
- If you want to display the line hierarchy graphic, then in the line hierarchy menu select Line segments.
- If you want to display the line hierarchy as an object tree, then in the line hierarchy menu select the tab page Object tree.
Processing the Line Hierarchy Using the Graphic
Create Line Segments

Prerequisites
You have created a work center in the system for all the line segments you want to create.

Procedure
1. In the line hierarchy menu, choose Line segments.
   
   The system displays the graphic display of the line hierarchy, which already contains the header of the line hierarchy.

2. Create the other line segments, that you would like to insert in the line hierarchy.
   
   a) To do so choose Line segment.
      
      The dialog box entitled Select line segments appears.
   
   b) Enter the selection criteria for choosing the work centers, which you want to create as a line segment and select .
      
      The system displays a list of the selected work centers.
   
   c) Select the required work centers and choose .
      
      The system displays the newly created line segments in the screen section Node area.

3. In the field Node area, select the line segment that you want to insert and click the line segment in the graphic where you want to insert it.
   
   Depending on the default settings, the system inserts the new line segment under or beside the line segment. You can change these settings under Edit → Default settings → Insert.

4. Repeat the previous step until you have inserted all of the line segments.

5. You can move line segments using drag & drop within the same level of a branch of a line. If, however, you want to change the assignment of a line segment to a line branch, choose and finally drag a connection line from the higher level line segment to the line segment that you want to assign.

6. If you have created parallel sequences as feeder production lines in the rate routing, define the line segments in which you want to carry out these sequences. Select a line segment and then choose the menu path Line segment → Feeder production line → Define.
   
   The system defines the feeder production line and indicates it by broken lines and broken connection lines.

7. To display the detailed data for the work center, which is assigned to a line segment, select the line segment and choose Goto → Work center.
   
   This takes you to the display mode of the work center.

8. Choose .

9. If you want to test the result in an object tree, choose the tab page Object tree.
Create Line Segments

You can display the individual capacities of a line segment by expanding the nodes of the object tree. The individual capacities which are used for scheduling are displayed in red.

10. Save your entries.

Result

You have created the line hierarchy by means of a graphic and have defined the feeder production lines. Now you can insert standard or sort buffers into the line hierarchy and if necessary you can define visualization segments, planning segments or capacity segments.
Defining Number of Takts and Capacities

Use

You use this function to define the number of takts (processing stations) and individual capacities (such as personnel or machinery) in a line segment.

- **Number of takts**
  
  You can define how many processing stations are in a line segment, for the purposes of takt-based scheduling. This means that you do not have to create a line segment (work center) for each processing station. The number of takts multiplied by the minimum takt time is the amount of time that a material spends in a line segment.

  If you work with lead time scheduling via routing, the system does not take into account the number of takts when calculating the operation duration. If you want to represent parallel work in the system using splitting, you must therefore create a line segment (work center) for each takt.

- **Number of individual capacities**
  
  You can increase the capacity of a line segment by multiplying the number of individual capacities on the work center. With the amount of individual capacities, you define, for example, how many personnel or machines are used at line segment. This modified amount is only valid in the line hierarchy, since the system does not change the work center.

You can define an unlimited amount of takts and individual capacities for a production line. Since the amount must be uniform for the whole production line, you can only enter the takts and capacities in the branches of the line hierarchy (from the uppermost level downwards) on one level respectively (see also Example of Number of Takts and Individual Capacities [Page 62]).

Integration

- The number of takts and individual capacities should be sufficient to cope with the maximum capacity load utilization of the production line (maximum production rate). When carrying out line balancing for the line hierarchy, you can change entries to adjust the production line capacity to suit the planned production rate, in case of changes in the requirements situation. Any entries made in a version of a line balance are only valid for that version. The system does not change the entries in the line hierarchy, unless you have selected Maximum line balancing in the line balance.

- In the line balance, the system displays a separate row for the line segments, for which you enter takts and capacities. These line segments are therefore relevant for line balancing. Operations from the routing can be moved between these line segments.

  In the line hierarchy, you can flag the amount of takts as relevant for line balancing. Then the system displays a separate row for each takt.

- The total of all the takts in the line segment equals the length of the production line that Sequencing uses for scheduling based on takts.
Defining Number of Takts and Capacities

Prerequisites
You must work with scheduling based on takts in Sequencing or in discrete manufacturing.

Features
- The system compresses the number of takts and individual capacities upwards from the level that they entered on. The amount of takts is displayed in each line segment in the line hierarchy. The total amount of takts on the production line (length of the production line) is displayed in the line hierarchy header.
- You can multiply the number of individual capacities for each capacity category in the work center. The system does not copy the changes to the work center. They are only valid for the line hierarchy.

Actions
1. Starting from the line hierarchy graphic, select a line segment and then the menu path Edit → Takt/capacity details.
   You branch to the screen Number of takts/individual capacities.
2. Enter the amounts in the appropriate areas.
3. Choose Continue.
4. If you want to check the number of individual capacities per line segment in an object tree, choose the tab page Object Tree in the line hierarchy menu.
Example: Number of Takts and Capacities

This example shows a line hierarchy with two segments beneath the header of the line hierarchy (two branches).

In the first branch there are two hierarchy levels. The number of takts and the number of individual capacities are given on the lowest level. The system displays the summarized number in the uppermost level. The first branch then, has four takts and five individual capacities. The individual capacities can, for example, be people or machines.

The second branch consists of one hierarchy level only and therefore of one line segment only. For this line segment there are two takts and two individual capacities.

The total number of takts and the overall length of the production line is, therefore, six takts. In this example the takts are connected by a conveyor system. A material passes through each of these takts and remains there for the minimum takt time of ten minutes.

The system distributes the individual capacities available in a line segment equally over the number of takts. In segment_3, for example, there are three people working on two takts. Therefore, two people at a time can work on one takt for the minimum takt time of ten minutes. The third person can work on both takts, each for five minutes.

On the pre-condition that both takts in segment_3 have been defined as relevant to line balancing, the system reproduces segment_3 in the capacity view of the line balancing in the following way:
Example: Number of Takts and Capacities

<table>
<thead>
<tr>
<th>Segment_3 -Takt_1</th>
<th>00........10........15........20........25 [min]</th>
</tr>
</thead>
<tbody>
<tr>
<td>Material A</td>
<td>Operation 10  Operation 20</td>
</tr>
<tr>
<td>Material B</td>
<td>Operation 10  Operation 20</td>
</tr>
<tr>
<td>Segment_3 -Takt_2</td>
<td></td>
</tr>
<tr>
<td>Material A</td>
<td>Operation 30  Operation 40</td>
</tr>
<tr>
<td>Material B</td>
<td>Operation 30  Operation 40</td>
</tr>
</tbody>
</table>

The line balancing graphic displays a separate segment for each takt. Since the model mix contains the line balance of two materials, the graphic displays one row per material in each takt. The white area of a row shows the time available in the row. The time available for both takts is 30 minutes. This can be calculated from the following formula:

Time available = Minimum takt time * Number of individual capacities

This time is distributed across two takts. Therefore each takt can be used for 15 minutes, although the material only remains in each takt for 10 minutes.
Defining Sort Buffers

Use
You can use this function to insert sort buffers in the line hierarchy. Sort buffers are buffers, in
which the sequence of planned orders may change. By inserting sort buffers in the line hierarchy,
you split the production line up into buffered sections. You can then enter a processing profile for
each buffered section, which Sequencing uses to determine the sequence of planned orders in
scheduling.

The buffered sections also give you additional display options in Sequencing and in the planning
table.

Prerequisites
You must have created a line segment to be defined as a sort buffer. The line segment must lie
on the first level of the hierarchy directly below the line hierarchy header, between two other line
segments. You can also define the first line segment of the line hierarchy as a sort buffer.
However, such a sort buffer does not have any function.

Features
- Any line segment can be defined as a sort buffer if it lies on the first level of the hierarchy,
between two other line segments, but has no subordinate line segments.
- Sequencing can change the sequence of the planned orders in a sort buffer when
  scheduling. You can assign a processing profile to each buffered section. The processing
  profile defines how Sequencing determines the sequence of orders in a sort buffer (for
  example, FIFO).
- You can enter different operating times for each buffered section. If you have inserted buffers
  in the line hierarchy, the system determines the operating time from the first line segment
  and from the line segments that come directly after sort buffers. You enter the operating time
  in the capacity data for the work center that is assigned to the line segment.
- You can define line segments in the first hierarchy level as planning visualization segments.
The system then displays a separate row per visualization segment in Sequencing and in the
  planning table.
- If, instead of scheduling based on takts, you use lead time scheduling in conjunction with the
  capacity planning table, you can define the line segments, to which you have assigned
  operations from the routing, as visualization segments. The system then displays the
  capacity load utilization resulting from the operations in a separate row per capacity segment
  in the planning table.
- If you use Sequencing, you can insert a planning segment in the first level of the hierarchy.
The planning segment is the basis of scheduling in Sequencing. The production start and
  finish dates in the planning table always refer to the first and last takt in the planning
  segment.

Actions
Select a line segment in the hierarchy level directly underneath the line hierarchy header, and
then the menu path Line segment → Buffer → Sort buffer → Define.
Defining Sort Buffers

The system classifies the line segment as a sort buffer and displays it in color.
Defining Processing Profiles

Use

If a production line has been divided into buffered sections using sort buffers, the sequence of the planned orders can be changed when scheduling in Sequencing. You can also assign a processing profile to each buffered section. The processing profile defines how the system determines the sequence of orders in a sort buffer (for example, FIFO). This enables you, for example, to use an external optimization procedure to plan sequences for the paint shop by setup time family, while for assembly you plan sequences based on an even capacity load utilization at processing stations.

If you have not inserted any sort buffers, you can enter a processing profile for the line hierarchy header.

Integration

- Each profile that you defined in Customizing for Sequencing can be entered in the line hierarchy. These entries overwrite the processing profile assigned to the plant in Customizing for Sequencing. You can access the line hierarchy from Sequencing and change the processing profile of a buffered section.

- Since the sequence of orders can be changed in a buffer, Sequencing creates a schedule record for each buffered section when scheduling.

Changes in the sequence of planned orders in a sort buffer can cause a considerable increase in the lead time of an order. The planned orders must wait in the sort buffer until the first planned order in the new sequence comes into the sort buffer.

Prerequisites

You must have defined at least one sort buffer in the hierarchy level directly underneath the line hierarchy header.

Actions

1. Select the first line segment in the first level of the hierarchy, or the first line segment of a buffered section, and select the menu path Line segment → Processing profile.
   This gives you the dialog box Processing profile.

2. Enter a processing profile.

3. Choose Copy.
Defining Planning Segments

Use

The planning segment is the line segment that controls how the order quantities are displayed in the planning table. The planning table displays a row for the planning segment in the Material data section of the screen. In this row, you can check the planned orders dispatched to the line segment and, if necessary, change them.

You define the planning segment in the line hierarchy. You can change the planning segments from the planning table.

Integration

- Lead time scheduling / capacity planning
  
  The planning segment is the basis of scheduling for lead time scheduling in conjunction with capacity planning. In lead time scheduling, the system carries out mid-point scheduling around this work center. In other words, the operation with the planning segment is the mid-point, and this is scheduled first. Starting from this operation, the system schedules the preceding and subsequent operations. The planning segment is usually the bottleneck work center.

- Sequencing

  The planning segment is the basis of scheduling in Sequencing. The production start and finish dates in the planning table always refer to the first or last takt of the planning segment, depending on whether you have set the view to line-on or line-off.

Features

The system defines the line hierarchy header as planning segment as default.

- If you do not define a planning segment, the system uses the line hierarchy header as planning segment for the planning table. If you use Sequencing, the system determines and displays the production start and finish dates for the whole production line.

- If you work with lead time scheduling, you can define any line segment as planning segment.

- For Sequencing, it only makes sense to define a planning segment if you have inserted sort buffers in the line hierarchy. You can then define a line segment from the hierarchy level directly below the line hierarchy header as planning segment. The system then only determines the production start and finish times for the buffered section.

- The system displays the planning segment graphically by shading the appropriate line segment in the line hierarchy.

Actions

In the line hierarchy graphic, select a line segment and then choose Planning segment.
**Example of Sequencing**

The following diagram shows a line hierarchy with no sort buffers. The planning segment is the line hierarchy header. The *planning table* therefore displays the production dates for the whole production line between “takt 1” and “takt 7”.

![Diagram](image)

The following diagram shows a line hierarchy with a sort buffer. You have defined “line segment 2” as planning segment. The *planning table* therefore displays the production dates for “line segment 2”, between “takt 3” and “takt 5”.

![Diagram](image)
Defining Planning Visualization Segments

Use

With this function you can define which line segments you want to display in the planning view of Sequencing and in the totals display of the planning table. The repetitive manufacturing planning tools display the planned orders of a visualization segment in a separate row. If a visualization segment has several takts, the display depends on which view you have accessed the planning tool from:

- The line-on view shows the dates on which the orders enter the first takt of the visualization segment.
- The line-off view displays the dates on which the orders leave the last takt of the visualization segment.

See also:

Line-On/Line-Off View of Orders [Ext.]

Integration

You firstly define the visualization segments in the line hierarchy in Line Design. You can change the visualization segments from the planning table and from Sequencing.

Prerequisites

As standard procedure, the system takes the line hierarchy header as visualization segment. If you have inserted sort buffers in the line hierarchy, you can define any line segment on the first level underneath the hierarchy header as the planning visualization segment.

Features

- If you do not define a visualization segment, the system uses the line hierarchy header as the visualization segment for planning.
- You can access the planning view in the line hierarchy to display all defined visualization segments in color.
Define Planning Visualization Segments

Prerequisites
You have inserted one or more sort buffers in the line hierarchy.

Procedure
1. Starting from the line hierarchy graphic, select the menu path View → Planning view.
   The system displays the visualization segments that are possible in white and the others in gray.
2. Select a line segment in the hierarchy level directly underneath the line hierarchy header, and then the menu path Line segment → Vis.segment planning → Define.
   The system displays the defined visualization segment in color.
**Defining Controlling Visualization Segments**

**Use**
You use this function to define which line segments you want to visualize in the control view in Repetitive Manufacturing. In the control view of *Sequencing*, all visualization segments and the sort buffers are displayed sequentially in a column of the sequence schedule. You can see which planned orders are in a line segment at a specific time of examination. The visualization segments must therefore cover the whole production line.

**Integration**
You define the controlling visualization segments initially in the line hierarchy in *Line Design*. You can change the visualization segments from *Sequencing*.

**Features**
- You can access the control view in the line hierarchy to display all defined visualization segments in color.
- You can specify the point of analysis to the minute. From the control view you move back or forward for a freely definable period.
- If you have not defined any sort buffers, the system uses the line hierarchy header as a visualization segment for controlling.
- If you have inserted sort buffers in the line hierarchy, the system defines all line segments on the first level of the hierarchy as controlling visualization segments (including the sort buffer).
- You can define an unlimited number of line segments as controlling visualization segments. The system then automatically selects neighboring line segments as visualization segments, ensuring that the production line is completely covered.

**Actions**
1. Starting from the line hierarchy graphic, select the menu path *View ➔ Control view*.
2. Select a line segment and choose `Vis Control`.
   The system defines the visualization segments of the control so that the production line is completely covered and displays it in color.
Defining Capacity Segments

Use
You can use this function if you work with lead time scheduling and capacity planning in conjunction with the planning table. You can define line segments as capacity segments, whose capacity data you want to display in the planning table. In the planning table, capacity data is displayed in a separate row for each capacity segment.

If you use the planning table in conjunction with the capacity planning table, you should define a maximum of one capacity segment, since the capacity planning table can otherwise give incorrect results.

Integration
You firstly define the capacity segments in the line hierarchy in Line Design. From the planning table, you can choose to hide or display capacity segments, as required.

Features
- You can access the capacity view in the line hierarchy to display all defined visualization segments in color.
- If you do not define a capacity segment, the system uses the line hierarchy header as a capacity segment.
- Each line segment, to which you have already assigned operations from the routing can be defined as a capacity segment. The capacity segments need not cover the whole production line.

Actions
3. Starting from the line hierarchy graphic, select the menu path View → Capacity view.
4. Select a line segment and choose Capacity segment.
   The system displays the defined capacity segment in color.
Defining Standard Buffers

Use

You can insert standard buffers in the line hierarchy to represent small interim storage locations on your production line. Standard buffers are only used for information purposes in the system, and are therefore not included in scheduling.

You can insert a standard buffer directly before each line segment, except the line hierarchy header. You do not have to insert work centers in the line hierarchy for standard buffers.

Actions

Select the line segment before which you want to insert a standard buffer, and select the menu path Line segment → Buffer → Insert standard buffer.
Manually Create Planned Rate

Prerequisites
You have selected the indicator *No line balancing* either on creating the line balance, or in the tab page *Management data*.

Procedure
1. In the line hierarchy menu, select the tab page *Planned Rates*.
   The system displays the overview, in table form, of the planned production rates.
2. Enter the following parameters for each period, for which you want to enter the planned rate:
   a) The start and end date of the period of time for which the planned rate is to be valid. Make sure that the periods of time do not overlap. If overlapping occurs, the system takes on the last period of time entered and adjusts the previous period of time accordingly.
   b) The planned rate in the unit of measure displayed and if necessary the number of time units displayed.

Result
You have defined the planned rate of the production line for the periods entered. You can override the planned rate of a period in the short term, by *Creating an Operative Rate* [Page 81] (e.g. for a shift).
Material-Dependent Rate

Use

If you work with a line hierarchy without line balancing and only produce one material at a time, then you can produce materials with various rates. In takt-based scheduling, Sequencing overrides the planned rate for the materials for which you have entered material-dependent rates. Sequencing schedules all materials, for which you have not entered a material-dependent rate, with the general planned rate for the production line.

If you work with a line hierarchy with line balancing, you can enter a model mix in the line balance. Therefore, material-dependent rates are not planned for this process.

Integration

Sequencing includes the material-dependent rates in takt-based scheduling.

Prerequisites

You have selected the indicator No line balancing for the line hierarchy. You can select this indicator on creating the line hierarchy or in the tab page Administration data.

Features

- The material-dependent rate allows you to override the planned rate for a certain material in takt-based scheduling. Since the planned rates are time-dependent, first of all enter the material-dependent rates in relation to the time-independent, maximum rate. The system then divides the material-dependent rate by the maximum rate and saves the result as the material-dependent factor. For takt-based scheduling, the system calculated the material-dependent rate by first of all determining the planned rate of the period and multiplying this by the material-dependent factor. In this way you ensure that the material-dependent rates are always adjusted in relation to the current planned rate of the production line.
### Calculation Procedure for Material-Dependent Rates

<table>
<thead>
<tr>
<th>Time-independent values</th>
<th>Period 1</th>
<th>Period 2</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Maximum rate 100 pc/h</td>
<td>Planned rate 80 pc/h</td>
</tr>
<tr>
<td></td>
<td>Rate material A 80 pc/h</td>
<td>* Factor material A 0.8</td>
</tr>
<tr>
<td></td>
<td>Factor material A 0.8</td>
<td>Planned rate Material A 64 pc/h</td>
</tr>
</tbody>
</table>

|                         | Planned rate 90 pc/h | * Factor material A 0.8 | Planned rate Material A 72 pc/h |

- You can enter any material-dependent rate for a material that is less than the maximum rate.
- You can display the material-dependent rates which the system has calculated for the periods, for which you have already entered planned or operative rates.
- If you change the maximum rate of a line hierarchy, the system automatically adjusts the material-dependent rates in comparison. The system multiples the altered maximum rate with the material-dependent factor.
- If you enter a material-dependent rate, the system shows whether the material concerned is assigned to a production line, using a status display. The system determines this assignment via the production version.

See also:

Example 4 for Scheduling

[Ext.]
Enter Material-Dependent Rates

Prerequisites
You have selected the indicator No line balancing on creating the line hierarchy, or in the tab page Administration Data.

Procedure
1. In the line hierarchy menu, select the tab page Material Dependent Rates.
   The system displays the overview, in table form, of the material-dependent rates.
2. Enter the material and the material-dependent rate in the table, in comparison to the maximum rate.
3. Choose .
   The system divides the material-dependent rate by the maximum rate. This results in the material-dependent factor, which the system displays in a separate column in the table.
4. Enter the other material-dependent rates in the table.
5. You can check the material-dependent rates, which arise in specific periods for takt-based scheduling. To do so, select a material and choose Control screen.
   This takes you to a dialog box, which displays the rates for the periods for which you have already entered a planned rate or an operative rate.
6. Choose , and then save your entries.

Result
Sequencing takes into account the material-dependent rates in takt-based scheduling.
Line Balancing

Definition

A line balance is the adjustment of the capacity of a line hierarchy to a specific model mix. The capacity of the line hierarchy is determined by the number of takts and the number of individual capacities in the line segments. The model mix is determined by several materials, the rate of the materials and the rate routings, according to which the materials are produced.

You can adjust the capacity by changing the number of takts (processing stations) and the individual capacities (people) and if applicable the assignment of the operations to the line segments. Here, the system automatically adjusts the rate routings in the background.

As the model mix generally changes with time, create the line balance as versions with a defined validity period.

Use

You carry out a line balance if you use Sequencing and if you produce several materials or material variants on a production line at one time.

With model mix production, operations and standard values for the individual materials in the line segments can vary. However, Sequencing does not take into account the execution times of takt-based scheduling, but multiplies the takt times with the number of takts. Therefore you must make sure, using the line balance, that the average work content [Page 64] of a takt or a line segment can be carried out by the individual capacities available in the time available. In addition you can change the amount of takts and individual capacities in a line segment, which you have defined in the line hierarchy. These adjustments are only valid for the respective version of the line balance. In this way you can adjust the capacity of the production line, which you have designed in the line hierarchy for a maximum load, for every version of the line balance or every period. The following graphic shows the connection between the line hierarchy and the capacity adjustment in the line balance.
Line Balancing

Structure

- If necessary you carry out a line balance for every period. Therefore, the line balance has versions with defined validity periods.
- A line balance version consists of the planned production rates of the model mix and of the reference to the assigned rate routings. In the line balance you can change the allocation of operations to takts in a graphic. In addition, you can adjust the amount of takts and the number of capacities of a line segment in the graphic.
- The line balance contains evaluations concerning, for example, the execution time of the materials.

Integration

- You can only create a line balance for a line hierarchy if you have not selected the indicator No line balancing on creating the line hierarchy or in the administrative data of the line hierarchy.
- You can balance standard routings and rate routings.
Processing Line Balances

Purpose
You use this process for the takt-based production of a model mix.

In takt-based production, all the processing stations (takts) of a production line have the same takt time [Page 11] for carrying out the operations. However, the execution times vary for the individual material in the model mix. In line balancing, you match the work content [Page 64] for each processing station with the given takt time, in order to achieve optimum capacity load utilization on the production line.

Since the planned production rates usually vary for each period, you have the option of creating several versions of a line balance with specific periods of validity. You can adjust the capacity on the production line for a version of a line balance.

You can assign a status of active or inactive to a version of a line balance. This enables you to create several versions of a line balance with the same period of validity, for simulation purposes.

Prerequisites

- You must not have selected the indicator No line balancing in the initial screen for the line hierarchy.
- You must have created one or more rate routings for the materials you want to produce.
- You must have entered the rate routing (or standard routing) in the production version in the material master.
- If you have assigned several operations to a line segment, these operations must belong to the same sequence.
- When creating the rate routing, you must have entered the operations in the same order as they are to be carried out later on the production line.

Process Flow

1. **Creating a Line Balance [Page 72]**
   Create a new version of the line balance. In a version of a line balance, you can change precisely one rate routing or routing for each material. When creating the line balance, you have the option of selecting routings from the production version or from a previous version of the line balance.

2. **Enter the Model Mix [Page 69]**
   Define the materials with the planned rates for this version. If you have already created planned independent requirements or planned orders for a material, you can have the system determine the planned production quantities.

3. **Carrying Out Line Balancing in the Graphic [Page 77]**
   In the line balancing graphic, you can move operations to other takts in order to adjust the work contents to the available capacity. The system then automatically changes the rate routing that the line balance is based on and renumbers the operations.

4. **Adjusting Takts and Individual Capacities [Page 76]**
Processing Line Balances

If line balancing results in a capacity load utilization that is too high or too low, you can adjust the line segment capacity in the line hierarchy accordingly. You can also change the amount of takts and the amount of individual capacities for the line segments. The system does not copy these changes to the line hierarchy. They are only valid for that version of the line balance.

You can copy the changed amounts from the line balance to the line hierarchy by selecting the indicator *Maximum line balancing* in the line balance. This could be useful if, for example, you wanted to use the changed amounts to define the maximum capacity load for a new line hierarchy.

5. Repeat steps 3 and 4 until you achieve optimum capacity load utilization on the takts and line segments.

**Result**

You have created a new version of the line balance. You can now set the status of the version to *active*, if you want to use the planned rate from the line balance for *Sequencing*. 
**Takts**

**Definition**

Takts are the processing stations in a production line. They are the spatial area that the material passes through in the predefined minimum takt time, where it is processed.

**Use**

You define the length of the production line by the number of takts. Alongside the rates and takt times, the number of takts that a material has to pass through is a further parameter for takt-based scheduling.

You can define the number of takts in the line hierarchy for a line segment. Since the number of takts on the production line must be uniform, you can only enter it in the branches of the line hierarchy (from the uppermost level downwards) on one level.

The number of takts on the lowermost level of the hierarchy gives you the number of takts on the uppermost level.

**See also:**

[Example: Number of Takts and Capacities [Page 62]]
Example: Number of Takts and Capacities

This example shows a line hierarchy with two segments beneath the header of the line hierarchy (two branches).

In the first branch there are two hierarchy levels. The number of takts and the number of individual capacities are given on the lowest level. The system displays the summarized number in the uppermost level. The first branch then, has four takts and five individual capacities. The individual capacities can, for example, be people or machines.

The second branch consists of one hierarchy level only and therefore of one line segment only. For this line segment there are two takts and two individual capacities.

The total number of takts and the overall length of the production line is, therefore, six takts. In this example the takts are connected by a conveyor system. A material passes through each of these takts and remains there for the minimum takt time of ten minutes.

The system distributes the individual capacities available in a line segment equally over the number of takts. In segment_3, for example, there are three people working on two takts. Therefore, two people at a time can work on one takt for the minimum takt time of ten minutes. The third person can work on both takts, each for five minutes.

On the pre-condition that both takts in segment_3 have been defined as relevant to line balancing, the system reproduces segment_3 in the capacity view of the line balancing in the following way:
The line balancing graphic displays a separate segment for each takt. Since the model mix contains the line balance of two materials, the graphic displays one row per material in each takt. The white area of a row shows the time available in the row. The time available for both takts is 30 minutes. This can be calculated from the following formula:

\[
\text{Time available} = \text{Minimum takt time} \times \text{Number of individual capacities}
\]

This time is distributed across two takts. Therefore each takt can be used for 15 minutes, although the material only remains in each takt for 10 minutes.
**Work Content**

**Definition**

The work content is the sum of the operation duration of all operations that are carried out in a takt of the line hierarchy. So, the work content corresponds to the time for which a takt is occupied. The system calculates the work content from the operation times in the rate routing.

**Use**

If you produce several materials on one line, the work content can vary in one takt for different materials. Therefore, you must ensure that the work content can be carried out in the pre-set takt time.

To do so, create a line balance of the line hierarchy, which is based on the model mix for a period. The system then calculates the operation times using the formula in the work center (e.g. for setting up, processing and taking apart) and evaluates these with the proportional factor which is in the model mix, per material. This provides you with the average work content per takt.

**Example:**

You produce 2 materials on a production line with the following rates:

- Material A 100 pieces/hour 25%
- Material B 300 pieces/hour 75%

The following work content occurs per material at processing station 1 (takt 5):

- Material A 10 minutes
- Material B 6 minutes

From this, the system calculates the following average work content of processing station 1 (takt 5):

\[(10 \text{ minutes } \times 25\%) + (6 \times 75\%) = 7 \text{ minutes}\]
Routing Selection

Use

When you create a line balance for a production line, the system determines the materials that you can produce on the line and the corresponding routing from the production version or from an existing line balance for that production line. The routing may be assigned to several materials. You can then change the routing in the line balance. You can make the changes with or without using a change number.

- With change numbers
  You separate the various line balances of a routing using change numbers. You therefore only need to save one routing in the system. When you create a new version of a line balance, it is based on the version that directly precedes it. It makes sense to use line balancing with change numbers if you create line balances at short intervals and use the routing for scheduling or capacity planning.

- Without change numbers
  Every new version of a line balance heads the routing, which is entered in the production version. Therefore, if you want to keep this routing in the system, you must first of all copy it and enter the copy into the production version. You can thus store several versions of a line balance simultaneously in the system. In addition, this method allows you the possibility of creating a line balancing version on the basis of a period in the past, since a copy of the routing in the system is available for every period.

It makes sense to use line balancing without change numbers if you create line balances at short intervals and do not use the routing for scheduling or capacity planning, or if you only create line balances at longer intervals.

The following table shows the purpose of each method:

<table>
<thead>
<tr>
<th>Requirement</th>
<th>Change number</th>
<th>Several routings</th>
</tr>
</thead>
<tbody>
<tr>
<td>You want to create several line balances for the same routing</td>
<td>-</td>
<td>X</td>
</tr>
<tr>
<td>You want to create a line balance, not only based on the currently valid line balance</td>
<td>-</td>
<td>X</td>
</tr>
<tr>
<td>You want the line balance to become valid at a specified point in the future</td>
<td>X</td>
<td>X*</td>
</tr>
</tbody>
</table>

* Only possible if you create various production versions with various periods of validity, and do not use quota arrangement via production versions

Integration

For further information on creating routings with reference to a change number, see the PP routing documentation, under Working With History [Ext.].
Process Line Balances

Prerequisites

- You must not have selected the indicator `No line balancing` in the initial screen for the line hierarchy.
- You must have created one or more rate routings for the materials you want to produce.
- You must have entered the rate routing (or standard routing) in the production version in the material master.

Procedure

1. Starting from the main Line Design menu, choose `Line balance → Create`. The system displays the initial screen for line balancing.
2. Enter the following data:
   a) the plant
   b) the line hierarchy, for which you would like to create the line balance
   c) the version number of the line balance, which you are free to choose
   d) the validity period or a change number

   You can no longer subsequently change the `Valid from` date.
3. Choose whether the system should select the materials via the production version or via an existing version of the line balance.
4. Choose `Enter`. The system selects the materials that you can manufacture on the production line and displays these in the table on the tab page `Material`. If you have entered more than one production version in the validity period for a material, then a dialog box will appear, in which you can select the desired production version.
5. The number of takts and individual capacities entered in the line balance is only valid for the current line balancing version. However, if you are planning a new production line and would like to determine the necessary number of takts and individual capacities using the line balance, then you can transfer these entries into the line hierarchy. To do so select the indicator `Max.line balancing`.
6. Save the line balancing version.

Result

You have created a new version of the line balance. Continue by creating the model mix for the line balance and finally carry out the line balancing graphic.
A new version of the line balance always has the status *Inactive*. If you want to use the results of the line balance in *Sequencing*, you must set the indicator *Status* in the overview to *Activated*.

The validity periods of the active line balance must not overlap each other.
Enter the Model Mix

Prerequisites

You have created a new version of the line balance.

Procedure

1. Starting from the line balance menu, select Goto \( \rightarrow \) Model mix.
   
   This takes you to the tab page Model mix.
   
   a. If, on creating the line balance, you have selected the materials via the production version, the tab page lists all materials in a table, which you have assigned to the production line via the production version.
   
   b. If, on creating the line balance, you have selected the materials via an existing version of the line balance, the tab page lists all materials in a table, which are also contained in the version concerned.

2. If necessary, limit the choice of materials by selecting a material and then choosing Material.

3. For every material enter the rate in which you would like to produce it for the validity period of the line balance.

   The system has to be able to convert the units of measure of the rates into those of the production line.

4. If you want to determine the rate on the basis of receipts and requirements which are already available in the system, choose Receipts/reqmts.
   
   a. A dialog box appears, which displays the maximum and the average daily quantities of the planned independent requirements and the planned orders. You can change the time period in the dialog field.
   
   b. Enter the rate of the material in the column Rate.
   
   c. If you want to copy a value from the other columns, select a column and choose Column.
   
   d. Choose Copy.

5. Save your entries.

Result

The system adds up the rates of the materials. The sum gives the planned rate of the production line for this version of the line balance. The planned rate is displayed at the bottom of the tab page Model mix. This planned rate of the production line must not be larger than the maximum rate of the line.

You can change the maximum rate of the production line from the line balance, if you define, for example, the maximum load of the production line using this line balance.
Enter the Model Mix
Enter Material Variants in the Model Mix

Use

You require this procedure if you work in takt-based production with configurable materials. You create material variants of the configurable materials in the system and specify these material variants in the model mix of the line balance. You should create material variants that are produced particularly often or that are particularly critical.

For each material variant you create a material master record and link this to the configurable material.

Prerequisites

- You have created the configurable material in the system.
- You have created a material master record in the system for each material variant.

For further information see the documentation on MM – Material Master [Ext.] and on LO – Variant Configuration [Ext.].

Procedure

1. In the MRP data in the material variants master data enter the configurable material in the field Configurable mat. and select the indicator Variants.
2. Choose Variant configuration.
   - This takes you to the characteristic value assignment.
3. Evaluate the characteristics and then choose.
4. Enter the production line and the rate routing in the production version.
5. Save your entries.

Result

You have created the material variants in the system.

- Now you can manually add the material variants to the model mix of the line balance.
- If you create a new version of the line balance, the system automatically selects the material variants via the production version or the line balancing version.
Balancing Lines Using the Graphic

Use

You balance line hierarchies using a graphic display. When you access the graphic, the system displays the operations, in the appropriate line segments, for all the materials in the previously defined demand program.

If you work with material variants, the system includes the object dependencies of the operations in the routing. So, for each material, the system only displays the operations that have to be carried out for this material.

Prerequisites

You can only carry out line balancing for routings whose unit of measure corresponds to the base unit of measure for the material. The system cannot convert alternative units of measure.

Features

- Line segments display
  
The system displays a weighted average work content [Page 64] for each line segment. You can expand the line segment display. The system then displays the relevant operations in separate row for each material in the line segment. The system uses different colors to differentiate the rows of the various line segments.

- Operations display
  
The system displays a bar for each operation. The length of the bar represents the duration of the operation. The system calculates the operation duration from the standard values in the routing and the formulas in the work center.

- Time available in the line segments and the takts relevant for the line balance.
  
The time available, or the time for which a line segment or takt can be used, depends on the number of individual capacities (e.g. people). The system displays the time available as the white area in each row. The rest of the row is displayed in gray. If the bar for an operation exceeds the time available in a row, that part of the bar is displayed red in the system.

- Capacity view and scheduling view
  
  In the capacity view, the system displays the operations and their capacity requirements for the capacity that is relevant for scheduling. The system determines the capacity requirements using the appropriate formula in the work center. The system displays the operations with the duration, which it has calculated from the routing. The time available in a line segment is calculated from the amount of takts and the amount of individual capacities in the capacity that is relevant for scheduling.

  In the scheduling view, the exact planned takt time is displayed as available time in each row in the graphic. In this view, the amount of individual capacities influences the operation duration display, as the system distributes the total operation duration over the individual capacities. The scheduling view, therefore, does not display the actual operation duration.
The scheduling view will only give the correct result if you have selected the indicator *Required splitting* for the operations in the routing, and have left the field *Maximum number of splits* blank. The line segments must also have an amount of taks of 1.

- **Moving Operations [Page 75]**
  You can move operations from one position to another in the graphic using drag&drop.

- **Unassigned operations**
  The system displays operations that have not yet been assigned to any line segments in the line hierarchy in a special area at the start of the graphic. You can move these operations to the desired line segment.

The following diagram shows the graphic display of a line balance in the capacity view:
Renumbering Operations

Use

If you move an operation in the line balance, the system automatically assigns a new number to the operation, since it uses the operation numbers to determine the sequence of operations.

In doing so, the system tries to change only the number of the operation you have moved, preserving the operation numbers of all the other operations. In other words, the system searches for a ‘free’ number between the operation numbers of the now previous and subsequent operations. If there are no numbers free between these operations, the system also has to assign a new operation number to one of them.

Example:

<table>
<thead>
<tr>
<th>Before</th>
<th>After</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operation 20</td>
<td>Operation 20</td>
</tr>
<tr>
<td>Operation 30</td>
<td>Operation 40</td>
</tr>
<tr>
<td>Operation 40</td>
<td>Operation 40</td>
</tr>
<tr>
<td>Operation 50</td>
<td>Operation 50</td>
</tr>
<tr>
<td></td>
<td>Operation 45</td>
</tr>
<tr>
<td></td>
<td>Operation 50</td>
</tr>
</tbody>
</table>
Moving Operations

Use
In line balancing, you can move operations belonging to a routing from one line segment or takt to another, in order to achieve an even capacity load utilization on the processing stations.

Integration
When you move an operation to another line segment, the system automatically changes the routing by replacing the operation's work center with a new work center.

Prerequisites
You must have entered the same standard value key for the line segment to which you are moving the operation, as you did for the line segment you are moving it from. You enter the standard value key in the basic data for the assigned work center.

Features
- As the operations have to be numbered sequentially upwards in the routing, the system assigns a new operation number to the operation. 
- An operation bar in a row represents an operation that must be carried out for a certain material.
  - If you use the same routing for several materials, and operations do not always have to be carried out for all materials, then the operation bar is always determined by an operation and a material. If an operation has to be carried out for several materials, the system displays the corresponding operation bar for each of these materials. However, as you can only select one operation bar to move, the system automatically moves the operation for all the other materials too.
  - You can move an operation bar to any row of another line segment. The system automatically inserts an operation bar in the row for the appropriate material. In order to move an operation, therefore, you must not have expanded the line segment display.
Adjusting the Available Capacity

Use
This function enables you to adjust the available capacity of a production line to suit the business situation for a period of validity. The business situation is determined by the planned rate (takt time) which results from the model mix.

You adjust the production lines by shutting line segments or takts completely and then opening them again. You can also add or remove individual capacities (for example, personnel) to or from a line segment.

- Changing the amount of takts
  If you want to reduce the number of takts (in other words, close a work center), you must move the operations assigned to that work center to a different line segment or takt.

- Changing the amount of individual capacities
  If you want to reduce the number of individual capacities, you must make sure before finishing the transaction that the remaining capacities are sufficient to carry out the operations assigned, within the time given.

Integration
In the line hierarchy, you have created a number of takts and individual capacities sufficient to cope with the maximum load utilization of the production line (maximum production rate). In line balancing, you can change these numbers in order to adjust the capacity to suit the planned production rate. These adjustments to capacity are then only valid for the corresponding version of the line balance. The system does not change the entries in the line hierarchy.

See also:
- Defining the Number of Takts and Individual Capacities in the Line Hierarchy [Page 39]
- Example: Number of Takts and Individual Capacities in the Line Hierarchy [Page 62]

Actions
- To change the number for a line segment, mark a line segment in the line balancing graphic and choose Takts/capacity.
- To change the number in an overview of all line segments, choose Edit → Open/close takts in the line balancing graphic.
Carrying Out Line Balancing in the Graphic

Prerequisites

- You must have entered the same standard value key for the line segments, between which you want to move operations. You enter the standard value key in the basic data for the assigned work center.
- If you work with configurable materials, you must have created a material with rate routings etc. in the SAP system for each material variant.

Procedure

1. Starting from the menu for line balancing, select Goto \rightarrow Line balancing graphic.

   The system displays the line balance in a graphic. The system initially displays the weighted average work content per line segment.

   ![Image]
   You cannot display the line balancing graphic if the routing concerned is already being processed by an other user.

2. To check how the work content of the individual materials corresponds to the takt time of the line, you can expand the line segment display.

   To do this, position the cursor on the appropriate row and choose Edit \rightarrow Expand station/takt.

   The graphic displays operation bars (work contents) for each material whose operations are assigned to the selected line segment or takt.

   To expand all the rows, choose Edit \rightarrow Expand all stations/takts

   To close the rows again, choose Edit \rightarrow Collapse station/takt or Collapse all stations/takts.

3. To move an operation to another line segment, simply drag and drop.

   The system assigns the operation to the appropriate material, and assigns a new number to the operation.

4. You can adjust the capacity of the production line by closing or opening takts or work centers.
   a) To do this, select Edit \rightarrow Open/close takts.
   b) The system displays a dialog box, in which you can enter the amount of takts and individual capacities for each line segment.
   c) Enter the data and select Copy.

   You can also display this data for just one line segment, by selecting the line segment and the menu path Edit \rightarrow Takt/capacity details.

5. Repeat steps 3 and 4 until you achieve an even capacity load utilization on the production line.

6. Save the line balance.
Carrying Out Line Balancing in the Graphic

Result

You have created a version of a line balance with reference to a planned production rate, matching the work content [Page 64] of each processing station with the given takt time and capacity.

You can display evaluations of the execution times for the materials by selecting the tab page Execution.
Displaying Execution Times

Use
With this function you can evaluate execution times for:

- The materials in the model mix of the line balance.
- Individual line segments or individual takts, which are used in the line balance. For example, you can check the percentage load of the line segments after you have carried out the graphic line balancing.

You can also display the takt comparison as a measure for the quality of the line balance. The takt comparison tells you what percentage of the time available is not taken up with operations.

Integration
The system determines the execution time from the standard values of the operations in the rate routing.

Prerequisites
You have assigned all operations from the rate routing to the line segments.

Features
- You can evaluate the total execution time per assigned material.
- If you have a production line with feeder lines, you can evaluate per material, the sum of the execution times that lie in the critical path of the rate routing. This includes all operations in which a reduction of the operation duration leads to a reduction of the total execution time.
- You can display per material, the total execution time for value added and for non-value added operations in the rate routing. You must have indicated those operations in the rate routing accordingly, which do not contribute to value creation.
- You can display the average execution time for which each line segment and each takt in the line balance is occupied. The system determines the average value from the varying load of the individual materials.
- You can display the time available for every line segment and for every takt in the line balance.
- You can display the capacity utilization of each line segment and takt. The system determines the capacity utilization from the execution time used and from that available.
- Initially, the system displays the execution times of the materials in the upper section of the table. The material numbers are displayed in the column titles. In the lower section of the table the system displays the execution times of the line segments and the takts used in the line balance. The names of these line segments and takts can be found in the rows. This representation is possible if you have lots of line segments and few materials. If you have more materials than line segments, you can reverse the axes. Then the system displays the line segments and takts in the columns and the material numbers in the rows.
- You can display the takt comparison of the production line. The takt comparison tells you what percentage of the time available is not taken up with operations. It is a measure for the
Displaying Execution Times

quality of the line balance. If the takt comparison equals 0%, the time available is fully utilized. The system calculates the takt comparison with the following formula:

$$\text{Takt comparison} = \left( \frac{\text{Time available}}{\text{Time occupied}} - 1 \right) \times 100\%$$

**Actions**

1. In the line balance menu, choose the tab page *Execution*. The system displays the execution times in table form.

2. If you want to reverse the columns and rows in the display, choose .
Changing the Operative Rate/Takt Time

Use
You use this function if you want to override the planned rate for a short period of time. With the operative rate you can react to any short term changes in requirements or supply. For example, you can enter an operative production rate for a shift.

Integration
You can enter or change the operative rate in Line design, in Sequencing and in the planning table.

Prerequisites
You must have created a line hierarchy in the system.

Features
The operative rate controls the time that elapses between a material entering and leaving the production line, for the period entered. Therefore, the operative rate overrides the planned rate, as far as supplying material to the production line is concerned. The system still uses the minimum takt time to determine the time that a material spends in a takt.
Change the Rate/Takt Time

Procedure

1. Starting from the main Line Design menu, choose Line balance → Oper. rate/takt time → Change.
   This takes you to the initial screen of the table overview of the operative rates and takt times.

2. Enter the plant and the line hierarchy header and choose ✔.

3. The system displays the overview, in table form, of the operative rates/takt times.

   If you want to change the operative rate/takt time from Sequencing or the planning table, choose Goto → Oper. rate/takt time → Change from the appropriate menu.

4. Enter the following data for each period, for which you want to change the operative rate/takt time.
   a. The start and end date of the period of time for which the operative rate is to be valid. Make sure that the periods of time do not overlap. If overlapping occurs, the system takes on the last period of time entered and adjusts the previous period of time accordingly.
   b. If necessary, the number of the shift for which the rate/takt time is to be valid.
   c. The operative rate in the unit of measure displayed and if necessary, the number of time units displayed. The system calculates the takt time automatically from the rate and displays it.

5. Save your entries.

Result

You have defined the operative rate/takt time for the periods entered. The operative production rate overrides the planned rates and takt times.
Operational Method Sheets

Definition
Operational method sheets are printed, detailed operating instructions, which contain the operations of a rate routing, standard routing or an inspection plan. Operational method sheets can be:

- a cover sheet per routing, line segment or takt, which contains, for example, an operation overview
- one or more pages per operation of the routing, which represent the exact procedures on a line segment or a takt.

Use
You can display the printed work instructions at a processing station of the production line. You thus support the flexible use of the personnel capacity (job rotation), as your employees can be quickly trained in a new activity with the work instructions on the production line. You have the following options for printing operational method sheets:

- You can print detailed work instructions from the SAP System using the current word processing system Microsoft Word 97.
- You can freely define all data that you want to print. Thus, all data for an operation is available to you, such as the description, the default values, the components and the production resources/tools to be used.
- You can print the data in the form of tables or as a link to an individual field or graphics.

Structure
You can insert the following data from the SAP System into the operational method sheets:

- tables, which contain operation data, component assignments or production resources/tools
- graphics, which reproduce the workflow, for example
- data for individual fields from the rate routing, such as the name of a work center or data from the task list header.

Integration
The system uses the current Microsoft application Word 97 to print operational method sheets.
Example

Production line 32          Processing station 31

Operation name          Operation graphic

<table>
<thead>
<tr>
<th>Operation</th>
<th>Time</th>
<th>Cat.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operation 50</td>
<td>1 min</td>
<td></td>
</tr>
<tr>
<td>Sub-operation 51</td>
<td>1 min</td>
<td></td>
</tr>
<tr>
<td>Sub-operation 52</td>
<td>1 min</td>
<td>▲</td>
</tr>
<tr>
<td>Sub-operation 53</td>
<td>4 min</td>
<td>▼</td>
</tr>
<tr>
<td>Sum</td>
<td>6 min</td>
<td></td>
</tr>
</tbody>
</table>

Components

<table>
<thead>
<tr>
<th>Components</th>
<th>No.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Screws M16x20</td>
<td>2</td>
</tr>
<tr>
<td>Cable X1</td>
<td>3</td>
</tr>
</tbody>
</table>

Operation category: Quality △ Assembly ▶ Security ▼

Graphic
Printing Operational Method Sheet (OMS)

Use

You can use this function to print an exact operational method sheet for the operations in a rate routing, a standard routing or an inspection plan.

Integration

To print the OMS, the SAP System uses the current word processing system Microsoft Word 97. This word processing system is compatible with all 32-Bit operating systems, such as Windows 95 or Windows NT.

Prerequisites

- You have created a routing with all the operations and work centers that you want to print in the OMS.

  If you work with lead time scheduling and want to use a very simple routing, you can create an additional routing for printing the OMS. In addition, using the control key in the routing you can mark several operations as not being relevant for scheduling.

- If you would like to print graphics in your OMS, you must first of all create these as a document in the document management system in the SAP System. Then assign these documents to the respective operations as production resources/tools.

- You have defined the layout (print template) in Customizing for the OMS. You define this layout in Customizing under Production → Basic data → Line design → Operational Method Sheets. The layout defines the data, which are to be included in the print out. You can define tables and determine the number of graphics that you want to reproduce in the print out. Then create a Word document from Customizing and here enter the tables defined in the SAP System. In addition insert the links to the graphics and to the individual fields into the Word document. On printing, the SAP System sends the data to Microsoft Word, which fills out the tables, inserts the graphics and fields and finally prints.

- You have set the options in Microsoft Word to ensure that the SAP System can interact smoothly with it (Set Word Processing System [Page 89]).

Features

- You can print detailed operational method sheets per operation, which contain graphics and data from both tables and individual fields.

- You can create layouts for cover sheets, for example to print an operation overview for a rate routing, line segment or takt.

- You can select the operations for which you want to print an OMS either with a routing, a line balancing version or with the production version. In this way you can only print operations, for example, that you have assigned to a specific line segment or takt.

- On printing the material variants, the system takes the configuration into account. It only prints the operations, which also have to be carried out with the material variants.
Printing Operational Method Sheet (OMS)

- On printing, you can print the operations for several materials. You have the option of grouping the options of these materials to an OMS, if they are identical.

Printing Operational Method Sheets

Operation 10

Assessment:
- Material 1
- Material 2
- PR/T 1
- Document 1 (as PR/T)
- Document 2 (as PR/T)

20

Operation 20

Assignment:
- Material 1
- Material 2
- PR/T 1
- Document 1 (as PR/T)
- Document 2 (as PR/T)

Routing

Office Integration

Operation
- Work center
- Standard values

Material 1
Material 2

PR/T

Microsoft Word

Production line 1
Operation 10
Work center A
Standard values (times):

Component assignment:
- Material 1
- Material 2

Production resource/tool:
- PR/T 1

Document 1
Document 2
Grouping Materials

Use
With this function you can group several materials to just one operational method sheet, if the routings of these materials contain identical operations.

Integration
The system regards operations as identical, if:
- they come from the same super routing and are identical
- they come from different routings, but refer to the same operations in a common reference operation set.

Features
- The system groups several materials to one operational method sheet, if their operations are identical.
- With the grouping function, you can choose whether materials’ operations have to be identical per routing, line segment or takt, so that the system can group the materials.

Example
The following example shows how the system groups the materials, which are based on a common super routing. The operational method sheets should be grouped per line segment.
Grouping Materials

- In the first line segment the operations of all three material variants vary, so three operational method sheets have to be printed.
- In the second line segment the operations of all three material variants are identical, so only one operational method sheet has to be printed.
- In the third line segment the operations can be grouped for material variants two and three and so two operational methods sheet have to be printed.

Actions

1. On the screen Print Operational Methods Sheets under Grouping, choose the criteria with which you would like to group the materials.

   The options under Grouping also determine with which criteria the system groups the cover sheets.

2. Select the indicator Group material.
Set Word Processing System

Procedure

1. Start Microsoft Word 97
2. Choose Tools → Options.
   The dialog box entitled Options appears.
3. Choose the tab page View and deselect the indicator Field codes.
4. Select the tab page General and
   a. select the indicator Update automatic links at open
   b. deselect the indicator Macro virus protection.
5. Choose OK.
6. Close Microsoft Word 97

Result

You have taken on the settings, that are necessary to allow the SAP System to work together with the word processing program.
Print Operational Method Sheets

Use
You can use this procedure if you want to select those operational method sheets that are to be printed, using a routing, a line balance or a production version.

Prerequisites
- You must have created a layout in Customizing for the OMS.
- You must have set the necessary options in Microsoft Word 97.

Procedure
1. Starting from the main Line Design menu, choose Rate routing → Print OMS. This takes you to the screen Print Operational Method Sheets.
2. If you want to print operational method sheets for individual operations, enter a print template for the individual operations.
3. If you would like to print the cover sheets, enter a print template for the cover sheets.
4. If you want to group materials with identical operations to one OMS, select the indicator Group material.
5. Under Grouping, choose with which criteria you would like to group the materials and whether you would like to print a cover sheet per routing, work center or takt.

The option Grouping defines the grouping of materials and of cover sheets.
6. Enter the date on which the system is to select the routings.
7. Depending on the criteria, with which you want to select the operational method sheets, choose the tab page Routing, Line balance or Production version.
8. Enter the plant.
9. If necessary limit the selection further, by entering the following, optional data, depending on the tab page selected.

<table>
<thead>
<tr>
<th>Tab page Routing</th>
<th>Tab page Line balance</th>
<th>Tab page Production version</th>
</tr>
</thead>
<tbody>
<tr>
<td>one or more materials</td>
<td>the line hierarchy</td>
<td>the line hierarchy</td>
</tr>
<tr>
<td>a routing sequence</td>
<td>a version of the line balance</td>
<td>one or more materials</td>
</tr>
<tr>
<td>an interval of operation numbers</td>
<td>one or more materials</td>
<td>the production version</td>
</tr>
<tr>
<td></td>
<td>a line segment</td>
<td>a line segment</td>
</tr>
<tr>
<td></td>
<td>an interval of takts</td>
<td>an interval of takts</td>
</tr>
</tbody>
</table>
If you do not restrict the selection, make sure that the range of the operational method sheets to be printed can be very large.

10. If you want to control the print operation with a dialog field, select the indicator *Control printing*. You can then select in a dialog box whether
   a. you want to print all operational method sheets in one run,
   b. you only want to print the operational method sheets that are currently displayed. Then you have the possibility of changing the operational methods manually,
   c. you do not want to print the operational method sheets that are currently displayed,
   d. you want to end printing prematurely.

11. Choose 🖌️.

12. If the system determines several rate routings or production versions for one material, a dialog box appears. Choose 🖌️.

**Result**

The system automatically begins the word processing program, opens the document template and fills it with the data that you have defined in the layout. If you have not selected the indicator *Control printing*, the system prints all operational method sheets in one run. Otherwise you can control the printing operation.